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Feature Article

LIT Unveils New ILLINET Online System
For over a decade, ILLINET Online, our
online catalog, has enabled us to search the
holdings of our library and the holdings of
all libraries in the ILCSO consortium, and
has also provided us with the ability to charge
out items from any member institution.
Today, the ILLINET Online system, which
was developed in-house at the University of
Illinois Champaign-Urbana, is still reasonably functional, but relies on hardware and
software which is rapidly becoming obsolete.

A preview of the new ILLINET Online Catalog.

Following a thorough needs assessment and evaluation of alternatives, the ILCSO consortium decided to purchase a commercially-produced system from one of the leading vendors of client/server
library systems, Data Research Associates (DRA). DRA is used in hundreds of academic and public
libraries throughout the nation. UCLA and Harvard University are two of DRA’s larger academic
customers. On August 18, 1998, the old ILLINET Online system was quietly retired and the new
DRA version of ILLINET Online was unveiled.
With its unique design and flexibility, DRA brings many advantages to the new ILLINET Online
system. Various DRA modules such as the circulation and reserve modules (called CIRCLE), the
(see DRA, page 2)
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From the Director
Welcome back! All of us in LIT hope you had a
good summer and are rested and ready for the upcoming semester. The staff in LIT have been working very hard the past several months on a variety
of new and ongoing projects.

mer. More information about Jai, Nick, Anne,
and Diane appears later in this newsletter.

New administration system

Introducing the new people

By now, I’m sure that most of you are aware
that the College is in the process of implementing a new integrated information system. This
project has received a lot of our attention over
the past several months. This new system, developed by CMDS, is replacing our old, homegrown, labor-intensive administrative system.

First of all, I’m very pleased to announce the addition of four new staff members who joined LIT over
the summer. Jai Ragoo, Hardware Support Specialist; Nicholas Ritter, Assistant Network Administrator; Anne Kale, Technical Services Assistant –
Acquisitions; and Diane Snedden, Academic Technology Specialist, all began working for us this sum-

The implementation of a system of this size
and complexity is never easy, and ours has
certainly not been without its problems. We
are confident, however, that in CMDS we
have a system which will enable the admin(see Director, page 6)

We’re pleased to have this opportunity to provide
you with an update on some of the changes and
projects we have been working on.

LIT Liaisons and Contacts
Administrative Departments
Alumni/Development

Anchalee Hocharoen (5110)

Admissions

Vince Costa (5115)

Athletic Department

Nick Ritter (5112)

Business Office

Vince Costa (5115)

Dean of the College

Marylin Bell (5114)

Dean of the Faculty

Marylin Bell (5114)

Facilities Management

Gene Shin (5119)

Financial Aid

Marylin Bell (5114)

Marketing and Communications

Nick Ritter (5112)

President’s Office

Marylin Bell (5114)

Academic Departments
Humanities (except History & Music) Valerie Archambeau (5116)
Melinda Dermody (5063)
Music

David Levinson (5059)

Social Sciences and History

Diane Snedden (5113)
John Brandt (5066)

Natural and Mathematical Sciences Marylin Bell (5114)
Vanaja Menon (5057)

Contacts for Specific Services
Archives and Special Collections

Art Miller (5064)

Audio Visual Services

Mary Moss (5058)

Book Acquisitions

Anne Kale (5060)

Circulation (overdues, etc.)

Karen Ludlow (5061)

Computer Hardware Purchases

Linda Mathiesen (6220)

Computer Supplies

Jan LePak (5120)

Interlibrary Loan

Susan Cloud (5062)

LFBBS

Diane Snedden (5113)

Periodicals

Rita Koller (5065)

Reference Desk

5074

Software Licensing

Diane Snedden (5113)

Switchboard & Computer Supplies

Jan LePak (5120)

Telecommunications

Linda Mathiesen (6220)

Web Authoring

Valerie Archambeau (5116)
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DRA (cont’d from page 1)
cataloguing module (NETCAT), and the Information Gateway for
the public access catalog, all provide vast improvements over the
old system. The new system features pull-down menus which allow you to easily navigate from screen to screen with fewer keystrokes. When you want to initiate a remote charge for a book from
another library, you no longer have to specify which library you
wish to borrow it from. The system automatically does that for
you. The result will be the same — the book you request will be
delivered to our library — but then it will actually be checked out
through our circulation department, not the library from which the
book came. You will no longer be using your social security number when you request to borrow a book, but rather the barcode
number on your college ID card.
The DRA circulation module is much easier for our circulation
staff to use. Please note that the new system will not allow the staff
to charge out items to anyone who does not have a valid ID card.
You will also need your ID if you wish to use items that are in
Closed Reserve. The new catalog will allow you to look up all the
items charged out under your name and produce a printout of this
list if desired. The new reserve module enables you to view all materials placed on reserve for a particular course, and you can search for
this information by the instructor’s name or the course number.
Our staff in technical services are excited about the improvements
DRA offers as well. With the old ILLINET Online system, it would
often take more than two weeks for newly-cataloged materials to
appear in the online catalog. With the new system, newly-acquired
materials can be on the shelf without delay.
The new DRA version of ILLINET Online will continue to develop and improve over the coming months. In the near future, a
web version of the new ILLINET Online will be complete and
ready. This will be more sophisticated than the current telnet version that we will be using this semester. If you’d like to take a look
at the web version, you can follow the link from Library’s homepage
or point your browser directly to: http://pac.ilcso.uiuc.edu. When
you try it, please bear in mind that this is still a work in progress.
When completed, it will be extremely powerful and it will enable
simultaneous searching of multiple databases. We will have several
search guides available for your convenience. Watch for their arrival
in your mailboxes or stop by and pick one up in Donnelley.
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TechTips
New ILLINET Online Tips
␣ How to connect
Telnet
1. From on campus, open a Telnet program.
Examples of Telnet programs include NCSA Telnet, Better
Telnet, QVT Telnet and TeraTerm.
2. Select Open Connection from the File menu and type the
following address in the box: pac.ilcso.uiuc.edu
Through the Web
1. Connect to the Library’s home page http://www.lib.lfc.edu
2. Select Online Catalog from the Library’s home page.
A Telnet program should open and connect to ILLINET
Online. If a telnet program does not open, your Netscape
Preferences must be set to open a telnet program upon request. Call one of your LIT Liaisons for assistance.

7.
8.

How to get borrower Information
1.

2.
3.
4.
5.

6.
Dial in from home
1. Open your communication software.
2. Dial into the following phone number: 735-6200.
3. From the menu, select 5 for ILLINET Online.

Your Library ID Number and Pin Number
•
•
•
•
•
•

•

Your Library User ID is the 14 digit barcode number on
your LFC ID card.
This entire barcode ID number is needed to perform a variety of necessary functions.
Your Pin number is the last 4 digits of your social security number.
The Pin number is needed (in addition to the barcode user
ID) to check Borrower Information.
At the login menu, login with your Library ID barcode number rather than logging in as a Guest.
The ID number allows you to search the Lake Forest College Library collection as well as other libraries. It also allows you to request and order books from another library.
If you login as Guest, you will not be able to do these and
other functions.

How to request a book from another library
1.
2.
3.
4.
5.
6.

Ordering a book from another library is called “Requesting” in the new system.
Do a search and if you don’t find what you need at LFC,
select Limit from the Find menu.
At the next screen, select L to change Location.
From the following list, select None to remove the limit of
LFC as a location and press Enter for OK at the next box.
Select the desired item from the new list of choices.
When the item is on the screen, select Request from the
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Options menu
When the box opens up, type in you library user ID number
and press Enter.
Press Enter to Save the search and the following message
will indicate completion.
The new ILLINET allows you to check the status of your
library account, which means that you can see what books
you have checked out or requested and what fines you owe.
At any time, select Borrower Info from the Options menu.
The next menu provides these options: Items Checked Out,
Requests, Fines, and Change Pin
Select one of these choices and a box asking for your ID
and Pin will appear.
Type your 14 digit barcode number from your LFC ID in
the ID line and the last 4 digits of your social security number in the PIN line.
You borrower information will appear.

Voicemail Shortcuts
Quick call back
When you are listening to your Voicemail messages, you can call
back your on-campus colleagues with a touch of a button.
1.

2.

Navigate to the message of the person you wish to call. (You
do not need to be listening to the message for this feature to
work).
Press “9” on the key pad. The system then dials the number
of the extension that left the Voicemail message.

This feature does not work with off-campus numbers.

Forwarding messages to Voicemail
There are times when you need to concentrate on a project, and
may wish to avoid interruptions. For these occasions, you can forward your incoming calls directly to your Voicemail.
1.
2.

3.
4.
5

Press the “Forward” button on your hand set. The LCD
display will flash.
To forward your message to Voicemail, dial 6245 (which
spells M-A-I-L). (You can also dial any on-campus number you wish to forward your messages to.)
Press the “Forward” button again. The LCD display will
disappear. Your calls are now forwarded.
To disengage call forwarding, press the “Forward” button
once.
To reinstate forwarding to the same number, press the “Forward” button twice.
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TechTips
Computing Tips
Customizing your toolbars in Microsoft Office
Buttons and drop-down lists on the shortcut toolbars are convenient, but the standard versions may not contain all the commands
you frequently use in your work. Microsoft Office 97 and Mac
Office 98 allow you to customize your toolbar for your personal
work habits.
1.
2.

3.
4.

Click on the View menu and navigate to Toolbars, then select Customize.
Click the Commands tab, then click the category containing the command you want in the “Categories” box (for a
menu, click the “Built-in-Menu” category).
Drag the command or menu you want from the “Commands
box” to a toolbar of your choice.
Your selected command will appear on the toolbar in the
form of a button.

Sharing files with colleagues
It is not uncommon to want to share your files with colleagues.
However, many times the version, application, or platform
(Macintosh / PC) of the two computers involved do not match. You
may be running WordPerfect 3.0 on your Mac and she is running
Microsoft Word 97 on Windows 95. In many cases you will still be
able to share files. When doing so, keep the following points in mind:
•
•

•

A beginning tip: if you are switching between file types, it is a
good idea to first make a backup copy of your original file.
Generally, Macs will read PC (IBM) floppies, but PC computers will not read Mac-formatted floppy disks. Therefore,
use PC-formatted disks when transferring files between platforms.
In order to share files with someone, you it is helpful to
know the application (WordPerfect vs. Word), version (3.0
vs. 5.0), and platform (Mac / PC) of the two computers involved. New versions can read older versions, but not vice-versa.

When saving files to a new format:
1. Use the Save As command from the File menu. In the box
directly beneath the file name there is the “Save As Type”
box. Click on the drop-down arrow on the right to see the
list of alternative formats.
2. If you are not sure which program your colleague is using,
select “Rich Text Format” for word processors (a universally-readable format) or “Text (tab delimited)” for an Excel or Quattro Pro files.
3. After you select the file type, specify a location to save to
(such as the Desktop, or the floppy drive), and click on Save.

Help us help you
When you call your LIT liaison, please be ready to give the
following information about your problem:
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•
•
•
•
•
•
•

Platform of your computer (PC or Macintosh)
Operating system (Mac 0S 7.5.1, Windows 3.1, Win95)
If you are having a printing problem, tell us the model and
manufacturer of the printer.
Your extension and your office and or room location.
Whether or not the problem is occurring in only one application or across many different applications.
How long the problem has persisted.
If a problem is occurring intermittently, begin a record of
what, when, and how the problem occurs and presents itself. Write down any error messages displayed on the screen.

Simple quick fixes
•

•

•

Save what you can of your work, close the application, exit
or quit and then try opening the document from within the
application after you start the application again.
Try rebooting your computer and turning the printer off and
then on again to see if the problem can fix itself when the
computer or printer reinitializes.
Check the plugs.

Win 95 secrets
•

•

Explore the use of your right mouse button and you will
find many shortcuts. For example, in Microsoft Word, if
you right click on a word with a red underline, a menu will
appear with alternate spellings. Right click after you select
a file icon and you will be given the opportunity to cut and
paste.
Ready to shut down and stop working? In many applications, you can save time by using the Close All command
instead of closing the documents one by one. Hold down
your SHIFT key and pull down the File menu. Where the
Close command normally appears, you’ll see the Close
All command. Click Close All, and all open documents
will close. You will be prompted to save any changes to
documents before they’re closed.

Selection / highlighting tips in MS Word

1.
2.

3.
4.
5.

Tired of straining your eyes to position the insertion point
in exactly the right place when selecting and highlighting
text for editing?
Position the cursor anywhere within a word and double click
to select the entire word.
If you would like to select the word next to what you have
already highlighted, hold your shift key down and position
the cursor anywhere within the word you would like to select, then click. Now you should have two contiguous words
selected. This works for selecting contiguous icons as well.
Click in the left-hand margin next to a line to highlight the
entire line.
Double-click anywhere in the left-hand margin next to a
paragraph to highlight the entire paragraph.
Triple-click in the left-hand margin anywhere in the document and the entire document will be selected.
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Introducing the New Faces in LIT
Sarah Drehobl
Administrative Assistant
Our new Administrative Assistant is a familiar face at Lake Forest College, as Sarah Drehobl is a 1997 graduate with a degree
in English Literature.
After working for years as a student assistant, we are happy to welcome Sarah back
as a permanent staff member. Among many
other responsibilities, Sarah oversees access
to the Donnelley Room (immediately to
your right as you enter Donnelley Library).
Here patrons can view materials previously
requested from our Special Collections.
If the catalog ever says “Treasure Room”
or “Special Collections,” stop by Sarah’s
window and fill out a request form. The material will be available for viewing in the
Donnelley Room within one business day.

Nick Ritter
Assistant Network Administrator
Nick Ritter comes to the Lake Forest College from a position maintaining the network and computer systems at the Country
Day School.
As our new Assistant Network Administrator, Nick will help maintain network operations, support faculty and staff computers,
and support the Lake Forest Internet Consortium. (The Consortium consists of

LIT Events
Library Workshops
Learn more about ILLINET Online.
Monday, Sept.7-4:00 p.m.
Tuesday, Sept. 8-12:00 noon
Thursday, Sept. 10-10:00 a.m.
Monday, Sept. 14- 4:00 p.m.
Tuesday, Sept. 15- 12:00 noon
Thursday, Sept. 17-10:00 a.m.

schools and the city government offices in Lake Forest
that receive their connection
to the Internet from Lake
Forest College.)
A local resident, Nick graduated from Lake Forest High
School, has attended Ripon
College (a fellow-ACM
school), and has studied programming and interactive
media at the International
Academy of Merchandising
and Design.

Anne Kale
Technical Services
Assistant - Acquisitions

Nick Ritter, Jai Ragoo, Diane Snedden, and Sarah
Drehobl (Anne Kale – not pictured).

Many of you already know Anne Kale, as
she worked as an evening and Saturday Circulation Supervisor from 1995 until last
Spring. Anne is now our Technical Services
Assistant for Acquisitions. (Technical Services
orders, receives, catalogs, and processes new
books, getting them ready for the shelves.)

an Academic Technology Specialist. Previously, she was Technology Coordinator for
the Antioch schools. She is pursuing a
Master’s degree in Educational Technology
from National Louis University, to add to
her studies at Grinnell College and her degree in Journalism from Northwestern.

Departmental liaisons to the library should
contact Anne to place orders for new books,
compact discs, and videos.

Diane will coordinate support for the
Faculty’s information technology needs,
including teaching workshops, providing
software support, and troubleshooting computer problems. She will be involved in introducing new software applications to the
faculty, and is available for individual faculty training. She will oversee the licensing
of software for the campus and the management of the LFBBS system. Liaisons from
appropriate academic departments should
contact Diane regarding their IT needs.

Diane Snedden
Academic Technology Specialist
This summer, Diane Snedden joined us as

IT Seminars
Watch your email for more information
on these upcoming computing workshops:
Making Windows 95 Work for You
Using Microsoft Word
Introduction to Microsoft Excel
Using Netscape Mail
Searching the World Wide Web
Web Page Authoring

Faculty Workshops
All Library workshops will be in the
Language Lab of Donnelley Library.
Look for announcements of upcoming
workshops on searching FirstSearch,
Ovid and other Library databases.
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Dates to be announced
ILLINET Online
Web Course in a Box
Desktop Management
Netscape: Creating Student Mailing Lists
Product Demos

Jai Ragoo
Hardware Support Specialist
This summer saw a much appreciated increase in the number of LIT staff with the
creation of a new position, a Hardware Support Specialist. Formerly a student assistant,
Jai Ragoo became a permanent staff member this summer filling this new position.
As a student, Jai is a National Champion
Handball player while majoring in both
Computer Science and Business. While a
member of the LIT staff, Jai will work on “tool
belt” issues, helping maintain the vast array
of computer hardware on campus.
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What’s New in Library and Information Technology
LIT has added a number of new resources
over the past few months. Here is a sampling:

Ethnic Newswatch
This is a database of full text articles from
ethnic and minority newspapers and magazines published across the United States. It
provides an ethnic view of most academic
disciplines and subjects. Available: In the
library on the Reference area computer
workstations.

Lexis-Nexis Academic Universe
This database provides full text documents
from wire services, newspapers and magazines from around the world. In addition,
legal, academic, financial, and government
information can be found. Available: On
campus through the Library’s web page
www.lib.lfc.edu/databases/kn-dbs.html

MLA Bibliography

Web Course in a Box

MLA Bibliography is the primary index
source for literature, linguistics, and folklore studies. It provides citations to articles
and other publications from over 4000 journals and series published worldwide. Available: On campus through the Library’s web
page www.lib.lfc.edu/databases/arts.html

This spring LIT introduced a new online
service, Web Course in a Box (WCB). WCB
provides instructors with easy-to-use tools
to create online material for their classes.
Without knowing how to upload a file or
type a single line of HTML code, instructors can produce discussion forums, class
announcements, class schedules, and even
testing instruments for their students.

PsycInfo
This is an American Psychological Association database that covers professional and
academic literature in psychology and related disciplines. PsycInfo is an improvement over the previously available PsycLit
because it covers a longer period of time,
includes more resources and is accessible
from computers on and off campus. Available: On and off campus through
the␣ Library’s␣ web␣ page www.lib.lfc.edu/ovid/

One of WCB new features, the discussion
forum, creates a Web area for students to
respond to questions posted by the instructor. WCB also features a “Quiz Builder” for
online multiple choice or short answer tests,
which are then graded automatically.
For more information, or to set up an account, contact Valerie Archambeau at x5116
or via email at varchambeau@lfc.edu

Director, (cont’d from page 1)
istrative departments to work more efficiently through the sharing of data, and
will also bring us into compliance with
Year 2000 issues.

New online catalog system
Not to be outdone in the systems implementation business, the library staff has spent a
good portion of their summer implementing a new library system. The Illinois Library Computer Systems Organization
(ILCSO), of which we and approximately
47 other academic libraries are members,
recognized several years ago that the old
ILLINET Online system was in need of replacement.
Following a thorough evaluation process,
ILCSO selected a system designed by Data
Research Associates. DRA has been in the
library automation business for nearly two
decades and has placed systems in hundreds
of academic and public libraries throughout
the world. The new DRA system will continue to evolve and improve over the coming
months, and we are confident that you will
find it to be more user friendly and powerful
than the old ILLINET Online system.
Interestingly enough, when it came time to
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choose a new name for the new DRA system, no one could think of anything better
than ILLINET Online. So while the system
will be very different, the name will stay
the same. We will be offering several IO
training workshops in the coming weeks. A
schedule of these workshops can be found
in this newsletter and on the Library’s web
page: http://www.lib.lfc.edu

Library renovation
Many of you have asked about progress on
the library renovation project. As you may
recall, an architectural and engineering review of the building was completed early
last spring by the Chicago architectural firm
of Weese Langley Weese.
The architects concluded that the building
is indeed structurally sound and could accommodate a renovation and expansion that
would meet the requirements of the library
building program. Since last spring, a master planning firm, Spillman Farmer, has
been working with the administration to
study the long-range architectural and space
needs of the College.
At this point and time, it has been decided
that the renovation and expansion of

Donnelley should be done in concert with a
planned renovation of the Commons. Under such a plan, the two newly renovated
facilities will relate to each other architecturally and programmatically.

Revised liaison list
Finally, I’d like to call your attention to the
liaison list included in this edition of the
newsletter. We’ve incorporated many of
your suggestions in an effort to improve the
services that we offer.
Please keep in mind that you should contact your liaison for assistance with any type
of hardware, software, or library-related issues. Your liaison may not be the person
who ultimately addresses your need, but
s/he is responsible for ensuring that your
request is addressed and for keeping you
advised of the status of your request. I also
encourage you to make note of the schedule of upcoming workshops that are being
offered by LIT staff. We have a number of
interesting and useful workshops planned
for you this fall.
Please accept our best wishes for a successful fall semester.
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